


Welcome!

Welcome to the SpinWheel Field Guide! This guide is
designed to start you along the adventure of learning to
program your SpinWheel. This book represents just a small
fraction of the materials available on our website. We
recommend checking out our online content, particularly
the interactive tools, in paral lel to your explorations with
this book! Like a true field guide, you should keep referring
back to this book as you move to the online materials and
begin to write your own programs for the SpinWheel.

We encourage you to begin by completing our online
Getting Started with the SpinWheel adventure at
spinwearables.com/intro. I t is specifical ly designed to
show you how to program the SpinWheel, without having
to perform any setup on your computer. Afterwards you
can fol low the SpinWheel Initial Setup chapter to instal l the
software necessary to program the SpinWheel for yourself.
Then continue with the various adventures in this Field
Guide and online.

Learning a programming language is just l ike learning
a human language - it requires picking up some
vocabulary, and you might not understand everything at
first. With practice, you wil l become more comfortable with
writing your own programs and recognizing what different
l ines of code do. Don’t be afraid to try making
modifications to example code or to try writing your own
code - learning to program is al l about experimentation.
The more you try, the more you wil l discover, and the more
natural programming wil l start to feel .



We hope you wil l enjoy exploring physics, math, and art
with your SpinWheel!
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The Online Resources

We highly encourage you to jump between this book
and the online material at spinwearables.com/book. The
image to the right il lustrates how the chapters in this book
(fil led hexagons) connect to the webpages (unfil led
hexagons) . We have both adventures that make use of the
SpinWheel (double- l ined hexagons) and lessons that
explore in more depth the concepts behind the SpinWheel
(single- l ined hexagons) . Some adventures, l ike "Biology of
Sight," directly extend material in this book, while others,



l ike "Dancing with Color," are completely new and wil l help
you use the SpinWheel in even more exciting ways.

The online and print activities connect and build on
each other in even more ways than represented in this
drawing. For this reason, you’l l notice as you are reading
that we reference other chapters in this book and online
material . J ump around between the lessons and
adventures. Don’t worry if the first time you read a page
you don’t understand everything. By revisiting it, you wil l
gain even more from the page. This may be a new way of
learning and feel uncomfortable at first. However, it wil l get
much more natural and empowering as you progress.
Moreover, you wil l be learning a whole new way of
learning, the way engineers and scientists both learn and
create new knowledge.
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SpinWheel Initial Setup

Contents

Your kit contains a SpinWheel, a battery, a micro USB
cable and a paper copy of the SpinWheel Field Guide.

The SpinWheel has four main components: a power
source (the battery) , a sensor (for motion and magnetic
fields) , a set of l ights (the light emitting diodes, or LEDs) ,
and a micro computer (the brain of the device) .

The SpinWheel contains sensitive electronic
components. While they are securely soldered to the
device, they can break if jostled excessively. For this
reason, it is important to be gentle with your SpinWheel

We’re so excited that you are ready to use your
SpinWheel! This chapter provides details on the

contents of your kit and instructions for turning it on for
the first time. You’l l learn how to instal l the Arduino

software, which is necessary to program the SpinWheel,
and add a new program to your device! If you haven’t

completed the Getting Started with the SpinWheel
page online at spinwearables.com/intro, we

recommend you try it before continuing.
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when attaching the micro USB cable and when putting it
into a backpack, purse, or pocket. It is also particularly
important to treat the battery with care; do not puncture
or bend it. Storing the SpinWheel in a small pocket in your
bag or in the box you received it in wil l help keep it safe.

Quick start

1 . The battery of your SpinWheel might not be attached
when you receive it. Before attaching the battery, sl ide the
switch on the back of the SpinWheel to be on “USB.” Then
firmly insert the battery connector into the battery jack on
the circuit board. If you have difficulty, see our
troubleshooting guide (spinwearables.com/troubleshoot) .

2. Use a small piece of the adhesive strip included with
your SpinWheel to tape the battery to the device.

3. To turn on the SpinWheel, fl ip the switch on the back to
"BAT" (for "battery") . You should see it turn on and light up
brightly!

4. The SpinWheel comes preloaded with several basic
animations. You can press the button on the back of the
SpinWheel to toggle between different animations.

Unboxing the SpinWheel
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5. To turn off the SpinWheel, fl ip the switch to "USB".

6. To charge, plug a micro USB cable into the USB jack on
the back of the SpinWheel, set the switch to "USB" and
charge using a computer or USB- to- wall converter. Note:
the battery may require charging before use. Reaching ful l
charge takes approximately 1 hr.

The switch on the SpinWheel should be set to "USB"
whenever it is plugged into your computer, whether to
charge or to program. You should also keep the switch in
this position when you are not using the SpinWheel and for
long term storage to protect the battery from discharging.

Installing the Arduino software

Much of the joy of the SpinWheel comes from your
abil ity to change it and make it do whatever you wish! The
rest of this chapter wil l walk you through adding a new
animation to your SpinWheel. Do not worry if you find this
part challenging. Learning new things can be confusing at
first. I f you get stuck, check out the troubleshooting guide
online at spinwearables.com/troubleshoot and don’t be
afraid to experiment. While feeling confused is normal, it
wil l get easier as you go!

In order to write new animations for the SpinWheel, you
need a way to reprogram its onboard computer. We use
the Arduino software to communicate with the SpinWheel.

You can download the Arduino software from
arduino.cc/en/Main/Software#download. For step by step
help, Arduino has provided instructions for each operating
system at arduino.cc/en/Guide.

Configuring the Arduino software

Once the software is instal led, we have to configure it
to communicate with the SpinWheel.

1 . Fl ip the switch to "USB” and then plug your SpinWheel
into your computer with the provided micro USB cable.
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2. Open the Arduino software on your computer.

3. Open the Tools menu and go to Port. You wil l see a list of
serial ports on your computer; select the port that
corresponds to the SpinWheel.

If there are multiple ports and you are unsure which one to
use, simply unplug the SpinWheel and see which serial
port disappears when you do so. This port corresponds to
your SpinWheel. If you do not see a port appear or
disappear, make sure you are using the micro USB cable
that came with your SpinWheel as others may not have
the needed functionality.

4. Go back to the Tools menu and select Tools → Board .
Select Arduino Leonardo as the board (a.k.a. processor) ,
so that the software knows which “dialect” to use to talk to
the SpinWheel. Computer languages have dialects just l ike
human languages!

Properly selecting the board and port are essential for
the Arduino software to communicate with the SpinWheel.
If you are unable to upload code to the SpinWheel in the
next section, double check that the switch is set to "USB"
and that you have the correct board and port selected.

Use Tools → Port and Tools → Board to pick the port
corresponding to the SpinWheel and the "Leonardo" board type.
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Installing the SpinWheel libraries

1 . To get the first set of example programs you can run on
the SpinWheel, download our SpinWearables Arduino
Library using Sketch → Include Library→ Manage

Libraries....

2. In the search bar of the Library Manager, search for
SpinWearables and then click Install .

3. You wil l be automatical ly prompted to instal l two other
required libraries (NeoPixel for control l ing the LEDs and
ICM 20948 for reading the motion sensor) . You wil l need to
instal l both of these to use the SpinWheel.

Running a program on the SpinWheel

To test that your SpinWheel is working properly, you
can instal l a new program, or sketch, from the example
files to animate your SpinWheel.

1 . Choose a file to instal l by opening File→ Examples →

SpinWearables and picking one of the examples. For
instance, pick BlinkingFirmware. This wil l open a new window
with the code.

2. Upload the code to your SpinWheel by pressing the
upload button (the arrow at the top) .

Now your SpinWheel wil l have the new colorful bl inking
pattern (from BlinkingFirmware) you just uploaded.

Instal l ing Arduino libraries
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Troubleshooting

Sometimes, while uploading code, you might get an
error. While error messages wil l contain some information
about the cause of the error, figuring out how to fix it can
be confusing at first. Always begin by careful ly reading the
error and attempting to determine the problem. This might
seem overwhelming at first, but with some practice you
wil l learn to disregard the unimportant noise in the error
message and focus on the one or two words that point out
the actual problem. The troubleshooting guide online can
also be used to find solutions for some common problems.

Next Steps

Congratulations! You are now ready to continue with
the rest of the SpinWheel activities!

Feel free to open any of the other SpinWheel sketches
and upload them onto the device. Do not worry about
understanding what the code does, you wil l learn more
about this language in future lessons. We encourage you
to experiment with these examples! If you want to save
any changes, you wil l be prompted to save the sketch in a
new location (can be anywhere on your computer) . The
original file wil l always be available to open again.

Uploading a new sketch to your SpinWheel wil l
overwrite the sketch that came on it. I f you want your
SpinWheel to have the original sketch again, simply open
the SpinWheelStockFirmware example and upload it.

In future SpinWheel activities, you wil l be writing new

Upload programs to your SpinWheel using the Upload button
(highlighted in white) .
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sketches to animate the SpinWheel. To transfer a sketch
from your computer to your SpinWheel, simply connect
your SpinWheel to your computer, change the switch to
"USB", open the code of your new sketch in the Arduino
software, and press the upload button.

This SpinWheel Field Guide contains some hands- on
adventures and reference material . This material is found
in expanded versions online, along with many more
activities for you to enjoy. We highly recommend that you
make use of both resources. In addition, the online version
includes virtual SpinWheels that al low you to test and
experiment with your code and see what the result might
look like before uploading to your real SpinWheel!

Enjoy exploring all of the SpinWheel adventures in
your field guide and online!
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Customizing the
SpinWheel ’s Display

Approach this chapter the way you would approach
the first few lines of a foreign language you want to learn.
Try to pick out words that make sense, without worrying
about the overal l structure or proper grammar. As time
passes and you have learned new things, come back to
this chapter and see whether you can understand a bit
more of it.

Computers fol low instructions. They do not solve
problems on their own. So, when writing a program for the
SpinWheel’s onboard computer, you need to be very
explicit in the instructions that you write! The particular
language we are using requires our programs to have a
certain structure. In the Arduino software, if you navigate
to File→ New, you can see this basic structure for an
Arduino program. It includes two sections containing
commands: setup and loop. In later chapters we wil l see

Now that you have successful ly added a sketch to your
SpinWheel, let’s create a simple program to light up the

SpinWheel’s display. In this chapter, you’l l start by
writing a program (a set of written commands for a
computer to fol low) that l ights up your SpinWheel’s

large LEDs. At the end of the chapter, take some time to
experiment with the code you wrote in Getting Started

with the SpinWheel.
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how the commands in each section differ.
To produce a program capable of control l ing the

hardware of the SpinWheel (e.g. the LEDs and motion
sensor) , we also need to add a few more lines to the new
sketch. If you are curious about why you need these other
l ines, then check the Arduino 101 chapter.

Now we can add something to the loop() section of our
sketch to make the SpinWheel l ight up. You may have tried
this with the virtual SpinWheel in our online Getting Started
with the SpinWheel adventure. To start, let’s turn all the
large LEDs purple by simply adding two commands to the
empty line in the loop section of code we started above
and upload it to the SpinWheel.

Instead of typing this into the Arduino software, you
can open the code from Examples → SpinWearables →

Paper_Guide→ Purple_LEDs in the Arduino software and
upload it to your SpinWheel.

Sometimes when we write a sketch, it won’t upload. It
might be because we forgot a semicolon or made another
typo. Learning to find these errors can feel overwhelming
at first. I f this sketch fails to upload, first check that you
have the correct port and board selected. For more
suggestions, check out the troubleshooting guide on our
website.

You may remember from the Getting Started with the
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SpinWheel webpage that the command we wrote wil l
change the color of the large LEDs based on the values
given in the command. These values fol low the format of
SpinWheel. setLargeLEDsUniform(amount_of_red, amount_of_green,

amount_of_blue) . In this case, it wil l l ight up all of the large
LEDs purple. In the next chapter, we’l l explore more about
how we create a rainbow of colors using just red, green,
and blue light.

If you want to do something new, then try replacing
SpinWheel. setLargeLEDsUniform() with the command
SpinWheel. setSmallLEDsRainbow(100) . Try varying the number
inside of the parentheses and see what happens.

You can also replace that l ine with your code from the
Getting Started with the SpinWheel page
(spinwearables.com/intro) to customize your SpinWheel
even more. These commands are also listed in the back of
this guide in the SpinWheel Functions Reference. Keep
experimenting like you did on the virtual SpinWheel to
create beautiful designs from your imagination on the
SpinWheel’s interface!
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Mixing Color with Light

When light comes from the Sun (or most other sources
of il lumination) , we perceive it as lacking a hue (we call
this white l ight) . In reality, white l ight is made up of many
colors. You can use a prism to separate the components
of the mixture. A prism works by bending, or “refracting”,
l ight at different angles depending on its color, thereby
allowing us to see all of the colors that make up white
l ight. This is why if you let sunlight shine through a prism,
you can see a rainbow.

The light- sensing tissue in the back of our eyes, the
retina, has small cel ls that respond to some of these
colors. They are called “cone cells” and are classified into
three separate groups by the color that they sense the
best: red, green, or blue. Each of these groups of cells
responds to one of these three colors, but not the others.
For instance, the blue- sensing cones respond to blue light,
but they do not respond to red light, and vice versa.

If our eyes can sense only red, green, and blue, how
can we see yellow? Our eyes and brains have evolved so
that our red- and green- sensing cones both respond

Human perception of l ight and color has many curious
features rooted in biology and physics. In this chapter,

you wil l learn how to trick your eyes into perceiving a
rainbow of colors using only red, green, and blue LEDs.
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sl ightly to yellow. If our brain detects that both groups of
cones are activated, it knows to interpret the color as
yellow. We can see other colors this way too. For instance,
purple activates both red- and blue- sensing cones.

We can exploit this imperfection of our eyes to make
rich colorful electronic displays while using only three
colors. For instance, since our eyes cannot distinguish
between true purple and a mixture of blue and red, we
don’t need a purple l ight source, only blue and red lights
(and green for the other color combinations) .

White l ight being split into colors by a prism. The white l ight
shines on the prism from the bottom left, and a big part of it is

refracted and split as it passes through the prism.

An artistic rendering of a close- up of the back of the eye
showing the rods (black) and cones (triangles colored by type) .
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The SpinWheel’s colorful display takes advantage of
this. If you look closely at an LED on the SpinWheel, you can
see that it contains 3 small l ight sources placed very close
together: one red, one green, and one blue. Combining
these lights in different intensities al lows for a wide variety
of colors to be displayed on the LEDs.

To better see the components of an LED on the
Spinwheel, open Examples → SpinWearables →

Paper_Guide→ Mixing_Color and upload it to your
SpinWheel. Look closely at the SpinWheel’s LED that l it up
red; you should see 1 red light in the LED. Likewise, the blue
and green LEDs wil l also have 1 l ight in them. If you look
instead at the white LED, you should see 1 red, 1 green and 1
blue light inside it. When each light is turned on, the colors
combine to make white l ight.

At this point, we encourage you to try out the Biology of
Sight adventure online (spinwearables.com/sight) . You’l l
learn more about how your eye works and experiment with
coloring the SpinWheel’s LEDs. If you are wondering why
mixing color with paint (instead of l ight) is different, then
we recommend you check out our online lesson on Color
Theory (spinwearables.com/colortheory) .

An up- close picture of the SpinWheel’s large LEDs. Notice how
white is created from the red, green, and blue LEDs all being on,

while yel low is created by mixing red and green light. You can
make all the colors of the rainbow by varying the relative

amounts of red, green, and blue light.
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Arduino 101

Many simple computer chips for DIY projects use the
Arduino software, a platform for writing and uploading
code onto a physical device, l ike the SpinWheel. The
Arduino software uses a simplified version of C+ + . We wil l
begin to introduce this programming language here.

The skeleton of an Arduino program

As we discussed in Customizing the SpinWheel’s
Display, the Arduino software requires programs to have a
certain structure. The most basic program looks l ike this:

In this chapter, we’l l dive into each line of the code you
used to color your SpinWheel’s LEDs in the earl ier

chapters. We’l l expand on how to write an Arduino
sketch and explain how to monitor the output from the

SpinWheel’s motion sensors. We hope you wil l keep
coming back to this chapter as a reference while you

work through this book and start the online adventures.
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This program does absolutely nothing. It contains two
blocks (or sections) of code which start and end with the
brackets: { and } . For our program to do anything, we need
to fil l these blocks with instructions.

The first block is called setup and runs only once,
immediately after the device is powered up. This block is
used for setting up any initial conditions the SpinWheel
might require.

Next, there is the loop block. This block is executed
repeatedly "in a loop", starting immediately after setup is
done. The loop repeats itself until power is turned off. Most
of our instructions wil l be written in this block. They wil l
frequently involve measuring time or motion with the
SpinWheel and then producing a colorful pattern based
on these measurements.

Extra elements for a SpinWheel program

To produce a program capable of sending instructions
to the hardware of the SpinWheel (e.g. the LEDs and
motion sensor) , our program wil l require a few more lines.
The piece of code shown below starts with a comment,
which is an explanation directed at the person reading the
code. Any line that starts with two slashes (//) indicates a
comment and is diregarded by the computer. As you look
at other sketches, these comments wil l help you figure out
what the commands for the computer do.

When you turn on the SpinWheel, setup() is run once and
then the loop() block is run repeatedly until the SpinWheel

is turned off.
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Adding #include " SpinWearables. h" and using namespace

SpinWearables; before setup() ensures that the rest of the
program has access to the extra resources and
commands specific for programming your SpinWheel.

It is also necessary to add SpinWheel. begin() ; in the setup

block. This l ine makes sure that the SpinWheel hardware is
ready for the instructions that we wil l add in the loop block
of code.

The loop block is stil l empty, so this program wil l not do
anything interesting yet. However, our setup section is
complete; it prepares the SpinWheel to receive
instructions. Through our activities, we wil l rarely need
anything more sophisticated in setup.

Final ly, let us turn on an LED by adding two function
calls (or commands) in the loop section of code we started
above:

Open the code from Examples → SpinWearables →

Paper_Guide→ Red_LED in the Arduino software and
upload it to your SpinWheel. It should cause one large LED
to turn on in bright red.



1 7

Let’s discuss each line we added to the code:

• The first l ine, SpinWheel. setLargeLED(0, 255, 0, 0) ; tel ls the
SpinWheel to get ready to set one LED to the color
specified. The first item (also called a "parameter" or
"argument") in the parentheses identifies the affected LED
and should be between 0 and 7 (C+ + , the programming
language used by Arduino, starts counting at 0) . The other
three numbers are the red, green, and blue components of
the desired color. They have to be numbers between 0
(color is off) and 255 (color is on at ful l brightness) .
Together, this l ine of code looks something like:
SpinWheel. setLargeLED(LED_you_want_to_change, amount_of_red,

amount_of_green, amount_of_blue) .

• The line SpinWheel. drawFrame() ; signals to the SpinWheel
that we are done specifying actions to take. It tel ls the
SpinWheel to "draw" al l of the commands that were listed
above it. Without this l ine, the LED specified in
SpinWheel. setLargeLED won’t l ight up.

If you are eager to customize the SpinWheel in other
ways (for instance by lighting up the small LEDs) , check
out the list of ways to manipulate the SpinWheel’s LEDs
found at the end of this book and online at
spinwearables.com/allcommands.

To control specific LEDs use the numbering il lustrated here.
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Additional programming notes

While looking at the code, you may have noticed a few
things about the style of the programming language:

• We tend to have only one "command" per l ine. This
makes the code more readable.

• Each command is fol lowed by a semicolon ; . That
makes it easier for the computer to separate different
commands.

• Commands take the form of their name (e.g.
SpinWheel. setLargeLED) fol lowed by parentheses () .

• Inside these parentheses, we frequently put some extra
information: this information can control how a command
performs. For instance, in setLargeLED we have one
parameter that selects the LED we want to modify and
three parameters for the color of that LED.

• There are other ways in which LED colors can be
modified and motion be detected. We discuss many such
tools in later chapters and in the online material .

Receiving communication from your
SpinWheel

I t can be very useful to have a way to receive
messages from the computer chip (in our case, the chip
on the SpinWheel) you are programming. For instance,
you might want to see the values that the motion sensors
are recording. Having this information can also be very
important when attempting to find errors in some code
(commonly called debugging) .

Different computer languages provide different ways of
receiving messages from a computer chip. When working
with Arduino, you can use the Serial Monitor to see the
messages sent from your SpinWheel to your computer
over the micro USB cable. To access the Serial Monitor, go
to Tools → Serial Monitor in the Arduino software.
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For example, using the Serial Monitor, we can check the
output of the SpinWheel’s motion sensors. The sensors are
capable of detecting a magnetic field, acceleration, and
rotation. To start with, we wil l look at rotation. In the Step
Counter and Dancing with Color online adventures, we use
this output in exciting ways. Keep reading to learn more
and refer back here when you start these adventures.

The code below uses the Serial Monitor to record the
rotation of the SpinWheel around its x axis, as seen in the
diagram on the right. You can open this file from Examples

→ SpinWearables → Paper_Guide → Serial_Rotation.

To observe this rotation, try holding the SpinWheel by
the USB cable and rol l ing the cable between your thumb
and index fingers. When you upload this sketch, you may
notice that some of the small LEDs flash: this happens
because the serial connection disturbs some of the
electrical signals going to the LEDs.
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In the setup block, we start by tel l ing the device to send
messages at the right connection speed (the rate that
information is transferred between your SpinWheel and
your computer) using Serial. begin(9600) , Then, after
gathering information from the SpinWheel’s motion
sensor, we can print the message we want (in this case
the rotation in each dimension) using the Serial. println()

function. Notice how the value in Serial Monitor changes as
you spin the SpinWheel.

For now, this output might make more sense if you look
at it as a graph instead of just a l ist of numbers. To see a
graph, close the Serial Monitor and navigate to Tools →

Serial Plotter.
I f you’re curious, the sensor reading represents the

number of degrees the SpinWheel rotates a second. Don’t
worry if this doesn’t mean anything to you yet, we wil l

This picture demonstrates the three axes that the SpinWheel
can detect rotation around.

Graph of Serial Monitor output
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explain it further in future adventures. To learn more about
this and rotation around axes, check out the Dancing with
Color adventure online!

If you want to dive more into the Arduino software, the
Arduino community has very detailed resources. You can
start with their tutorial at
arduino.cc/en/Tutorial/Foundations.

This chapter expanded on some concepts that you’ve
already seen and wil l be useful as you begin to code the
SpinWheel in more complicated ways. Using the output
from the motion sensor wil l be essential for making your
own step counter, for instance. We wil l refer back to this
guide in upcoming lessons and adventures and hope that
you wil l use it as a reference.
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Creating Animations
with the SpinWheel

To create an animation or a video, we need a rapid
sequence of stil l images, cal led frames. These frames
must be displayed rapidly enough that they look like a
smoothly changing pattern to our eyes. This is true both
for a computer screen playing a video and for the
SpinWheel l ights changing their patterns.

In order to produce more dynamic patterns on our
SpinWheel, we have to modify the loop block. Remember
from the Arduino 101 chapter that the loop block
continuously repeats. So far, we have created patterns
that produce the same result each time the loop is run. To
begin writing more complex code, we need to introduce
the idea of variables. Variables al low us to store
information in the program and change that information

An animation is created by rapidly cycling through a
series of stil l images. You may be famil iar with

animations from watching cartoons, but we can also
create animations with the SpinWheel’s LEDs. After

finishing this chapter, check out the Intro to Animation
adventure on our website.
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as needed. To learn more about variables and other
important concepts for creating programs, check out our
Programming Building Blocks lesson.

To define a new variable we can add the fol lowing line
to the loop block:

This l ine of code reserves a location in the memory of
the computer. It also assigns the name which_LED to that
location and then stores the value 1 in it. By itself, this
variable doesn’t impact the output of the SpinWheel, but
we can use it to store the location of the LED we want to
l ight up.

Open the code you see below from Examples →

SpinWearables → Paper_Guide → Which_LED and
upload it to your SpinWheel. If you change the value of
which_LED, you’l l see a different LED light up.

In this code, every loop stil l produces the same result;
which_LED has the same value (of 1 ) every time loop() is run.
Let’s modify the code, as seen on the next page, to change
the selected LED every time loop is run. Load this file from
Examples → SpinWearables → Paper_Guide →

Update_Which_LED and look careful ly at the comments
to learn what each line does.

When you run this code, every loop increases the value
of which_LED by 1 . This value is then used in
SpinWheel. setLargeLED() to indicate which LED to light up.
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This concept is further il lustrated below. As each loop()

block is run, the value stored in memory for which_LED is
changed. Because the loop block runs many times a
second, we have added the line delay(500) to pause the
code for 500 mil l iseconds (0.5 seconds) before finishing
the loop. Without the delay, the lights would change too
quickly for us to see the change. Note that the small LEDs
don’t work when the delay function is used.

After setup is completed, the loop function repeatedly l ights up
the LED specified by which_LED and then increments which_LED by

one.



25

I f you are interested in seeing how the value of
which_LED changes as the code is run, you can make use of
the Serial Monitor introduced in the Arduino 101 chapter. In
the sketch you uploaded from the examples menu, there
are a few additional commands that refer to Serial . In the
loop block, the line Serial. println(which_LED) allows us to see
the value of which_LED. Open the Serial Monitor (Tools →
Serial Monitor) and then upload the sketch again to watch
which_LED increase as the code runs.

You may have noticed that after a few seconds your
SpinWheel stops lighting up. This is because the value in
which_LED no longer corresponds to one of the 8 LEDs on the
SpinWheel. For example, if which_LED equals 1 0, the code wil l
try to turn on LED number 1 0. Since it doesn’t exist, nothing
happens. To light up the SpinWheel again, unplug it and
toggle the BAT/USB switch. This restarts the code, running
setup again and starting which_LED over at 0.

What if instead you wanted this pattern to repeat itself
over and over again? Check out the Intro to Animation
adventure online to learn how to make the animations
repeat themselves and add much more color to them!

What if the computer itself created the images? This is called
generative art and you’l l learn how to do this in the animations

adventures that we have created and are found in our online
resources.
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Coding Building Blocks

Writing a computer program, whether an interactive
website or the hidden brain of a robot, starts by writing a
sequence of instructions in one of the many available
computer languages. In this lesson, we wil l use C++ , a very
popular older language that runs well on simple
computers l ike the SpinWheel’s microcontrol ler. While C++

has a specific set of commands and rules, the main ideas
are common to other programming languages. In fact, the
vast majority of computer languages share the same
patterns, just l ike how many human languages share
ideas such as the distinction between a noun and a verb,
or the difference between a word and a sentence. We wil l
describe the most important such patterns in this chapter.

This chapter wil l introduce you to many of the typical
building blocks programmers use to write code.

Knowledge of these concepts wil l help you write your
own more complex code for the SpinWheel. Refer back

to this content as you go through the online adventures
at spinwearables.com/book.
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Variables

Computer programs do one thing and one thing only:
process information. That information can be the time of a
mouse click, a voicemail on your phone, or a picture of the
road taken by a self- driving car. Before processing such
data, we have to tel l the computer to store it in its
memory. This is done using variables.

We wil l only discuss two types of variables: integers
and decimals. Other types do exist, but we won’t cover
them here. If you store a number as an integer, it must be
a whole number (l ike 2 or 301 1 ) and cannot have a

Variables are like labeled shelves for information. When you
need to save a number for later use, you put it in a variable of

your choice. Above we have number 3 stored in the variable a ,
number 4 stored in variable b and the number 7 is about to be

stored in a variable named e. We can pick the names for the
variables ourselves (any sequence of letters that is not

interrupted by whitespaces) .
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decimal component. On the other hand, a decimal can
have a decimal part (l ike 0.4, 560.1 7, or 2.0) . Integers are
easier for a computer to work with because it does not
need to store all of the data after the decimal point.
Treating them separately from decimals lets us have
faster code, which is especial ly important for small
computers that don’t have much storage space like in the
SpinWheel.

To define a new integer variable you need the fol lowing
line in your code:

This reserves a location in the memory of the
computer, lets us refer to that location by the name
my_special_integer , and stores the value 6 there. We can
name the variable anything as long as it is a single word
(or multiple words separated with underscores) . We
usually pick names that tel l us something about the
purpose of the variable. In this variable type, we can store
any integer we want as long as it is not too large (no
larger than roughly 30 000, due to limitations of how this
computer stores integers) .

If we want to work with decimals, we use the variable
type float instead of int. The name comes from the early
history of computers and is unimportant for our purposes
(how the decimal point can "float" between the digits) .

Here we stored an approximation of the number π in a
variable with the name pi. We could then use this variable
in other parts of our code to do computations that involve
circles.

Notice that throughout al l of our code we have used
the equality sign = to mean "store the value on the right in
the memory cell on the left". This differs from the usual
mathematical meaning of the sign, which usually means
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"check if the left and right side have the same value". You
can blame early computer scientists and their laziness for
the misuse of this sign in most modern programming
languages.

Now that you’ve learned more about variables, we
encourage you to look at the start of Arduino 101 that
discusses variables again. As you move onto the online
materials and deepen your understanding of the
SpinWheel, we encourage you to go back and forth
between these chapters and the online pages.

Functions

In computer programming, functions are commands
that take a few variables and do something useful with
them. Functions are reusable pieces of code. A function
can act l ike a calculator, computing a new value based on
the variables that are given to it. A function can also do
something that affects the world around it, l ike blinking an
LED, playing a sound, or sending a message.

Functions are tools provided in a given programming language
that are capable of ingesting a number of parameters and

producing (a.k.a "returning") some new value that depends on
the input parameters.
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Most programming languages have some functions
built into them, similar to how a new cellphone comes with
pre- instal led apps. We can use these functions without
having to write them ourselves.

Here is some code that uses an example function
called max that takes two numbers as input and returns the
larger number. The input values are also called the
arguments of the function.

Let’s step through each part of this code.

• int number_a = 5 assigns the value of 5 to the integer
variable number_a

• int number_b = 7 assigns the value of 7 to the integer
variable number_b

• int resulting_number = max( . . . . ) stores the result of max( . . . )

in the integer variable resulting number

• max(number_a, number_b) calls, or uses, the function max( . . . )

with two arguments, number_a and number_b, and returns the
larger number.

The value stored in resulting_number in this case would be
7.

Here is another example where one of the arguments
for our function is specified directly, without first being
stored in a variable. In this case, the value stored in
resulting_number wil l be 8 :

As you have seen, the typical syntax rules for the use of
a function are to put its arguments inside parentheses
immediately after the name of the function. You might
have seen this in math class with trigonometric functions
l ike sin(x) or cos(x) .



31

We can nest functions and use arithmetic operations
on the arguments as well . For instance, here we wil l use
two more functions, min which returns the smaller of two
numbers and sqrt which returns the square root of a given
number.

Can you explain why resulting_number is 4? Here is a hint:
sqrt(5- 1) = sqrt(4) = 2

In this diagram, you can see the order in which the computer
evaluates this piece of code. It first finds the minimum of

number_b and 2. It then subtracts 1 from number_a , then evaluates
the sqrt() function and multipl ies the output of by 2 . Final ly it

evaluates max() . This is similar to how when solving a math
equation, you first do anything within parentheses and then

work your way out.
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Creating your own functions

A large part of programming is creating your own
functions and building interesting, complex, and useful
functions out of small simple functions. Here we give an
example of how to write your own function that takes two
numbers, x and y, and returns their average, (x+y)÷2 . We wil l
name the function avg . Let us first write an example of how
this function would be used if it already existed. In this
code example, resulting_number wil l have the value of 3.0 .

To define this new function, we need to write down its
name, together with the type of data it wil l be producing,
fol lowed by a set of computational instructions:

Let’s step through each part of this code.

• float avg( . . . . . ) : The very first float specifies the type of
data the function wil l produce (decimals in this case) . This
is fol lowed by the name for our function, avg .

• (float first_argument, float second_argument) : In
parentheses, we have a list of the arguments the function
wil l be taking. Unlike when we call the function, we have to
specify their types, so we wrote float to denote working
with decimals. We also gave temporary names for these
arguments so that we can refer to them in the function.

• { . . . } : The curly brackets surround all the instructions.

• 0. 5*(first_argument+second_argument) : This is where the math
happens in our function. It is simply the sum of the two
arguments multipl ied by one- half.

• return : a keyword to state that the result of this l ine
should be returned to the code that called the function.
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We can have multiple sequential instructions inside the
block when the computation is more difficult. That is the
purpose of the curly brackets { } - to separate all the code
that defines our function from the rest of the program that
might be in the same file. For instance, here we wil l show
how to compute the fourth root of a number. The fourth
root of a number, or x raised to the 1 /4 power, can be
computed by taking the square root of the square root
and we wil l use this fact to write the fourth root function
below.

Maybe the functions avg and root4 seem too redundant
to you, and you would prefer to always write (x+y)/2

instead of avg(x, y) . This is a quite valid feeling for such
short functions, but as you build more complex programs
you wil l have longer pieces of code that would be
cumbersome to repeat every time. Functions let you have
a shorthand notation, so you do not need to make such
repetitions.

Functions that do not return values

Functions can also be used to change something in the
environment of the device instead of being used as
advanced calculators. Such functions do not return a
value and don’t need a variable to store their output. One
example is the delay function that pauses the computer for
the length of time specified by the input variable. In the
fol lowing example, cal l ing the delay function wil l pause the
program for 1 000 mil l iseconds (which equals one second)
before executing the next l ine:
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While this built- in function is nice, what if we want to
specify the delay in seconds instead of mil l iseconds?
When writing our own functions that do not have a return
value, we specify the type of data that the function wil l be
returning as void . This denotes that the returned value is
empty or "void". Our new function takes the number of
seconds as its input, calculates the number of
mil l iseconds corresponding to the provided number of
seconds and then uses the delay function to pause the
program for that length of time. We do not need to use the
return keyword because our function doesn’t return a
value.

Putting it all together

After we have created all the variables and functions
we need for our code to do what we want it to do, we need
to actually start the program. To do this, the program
needs to know what function to run first. In different
languages this is done differently. In our particular case,
we do it by defining two special functions: setup and loop.
Our computer is instructed to run these functions first. It
finds the setup function and runs it before anything else.
Usually this function is used to set up any settings we need
in advance. Then the computer repeatedly runs the loop

function, which is named this way because it runs in a

loop (or repeats itself) .
Let’s look at a large example that includes all these

features found at Examples → SpinWearables →

Paper_Guide→ Counter. I t wil l use the Serial. println()

function introduced in the Arduino 101 chapter in order to
send messages to the computer. Use the Serial Monitor

tool in the Arduino software in order to see these
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messages being sent back over the USB cable (Tools →

Serial Monitor) .
Read the comments in the code to try to understand

what each line does. One great way to test your
understanding is to consider what would happen if you
change the code. For example, if you changed the line
counter = counter + 1; to the line below, how would the
output change?

counter = counter + 2;
Variables and functions are two of the most important

building blocks of programming. At this point, we
encourage you to jump into the online adventures, to
continue discovering more about programming!

Now you have the pieces to begin creating your own SpinWheel
code. In the beginning, this may be like creating a poem using a

limited set of magnetic word tiles. With practice, your bank of
pieces wil l increase in size, enabling you to write more

complicated code.
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SpinWheel Functions
Reference

LED manipulation

Turn on LEDs with drawFrame()
SpinWheel. drawFrame( ) ;

Below we wil l introduce a number of functions that let you
control the LEDs. However, for the LEDs to change in
brightness to reflect these functions, you also need to call
drawFrame() when you are done. drawFrame is the only "non-
instantaneous" function we have (commonly called
"blocking" functions) . It takes roughly 20ms for it to finish,
during which time it uses a persistence of vision method to
rapidly flash the small LEDs as necessary to mimic the
required color. This lends itself to making 50 frames- per-
second animations. By using drawFrame() you can make
multiple modifications, preparing the final image, without
the intermediate unfinished images showing up.

Turn off all LEDs with clearAllLEDs
SpinWheel. clearAllLEDs( ) ;

Use this function to reset the image, and set al l LEDs to be
dark, deleting any color information that they were
previously set to.

This chapter l ists some of the most important functions
available with the SpinWheel code library. With these
functions you can detect motion and set the LEDs to

different color patterns. This wil l serve as a reference as
you code the SpinWheel in whatever designs you

imagine.
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Turn on all large LEDs with setLargeLEDsUniform
SpinWheel. setLargeLEDsUniform( 255, 0, 155) ;

setLargeLEDsUniform takes three arguments, the red, green,
and blue components of the desired color. Their range is
between 0 and 255. While using a range like 0- 1 00 might
make more sense to you, the range of 0- 255 is better for
computers. Because computers use binary numbers, it is
more efficient to use ranges that are powers of 2, as in
256= 2�. The numbers 0- 255 can be represented in binary
with one byte, or one unit of computer memory.

Turn on all small LEDs with setSmallLEDsUniform
SpinWheel. setSmallLEDsUniform( 255, 255, 0) ;

setSmallLEDsUniform, same as setLargeLEDsUniform, takes three
arguments, the red, green, and blue components of the
desired color. Their range is between 0 and 255.

Control a specific large LED with setLargeLED
SpinWheel. setLargeLED( 4, 255, 155, 0) ;

The first argument of setLargeLED is a number between 0
and 7, denoting which of the 8 LEDs is to be turned on. See
the diagram for the numbering system. The other three
arguments are the red, green, and blue components of
the color.

To control specific LEDs in the commands presented below use
the numbering il lustrated here.
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Control a specific small LED with setSmallLED
SpinWheel. setSmallLED( 4, 155, 255, 0) ;

The first argument of setSmallLED is a number between 0
and 1 1 , denoting which of the 1 2 LEDs is to be turned on. The
other three arguments are the red, green, and blue
components of the color.

Turn on a range of large LEDs with setLargeLEDs
SpinWheel. setLargeLEDs( 0, 3, 255, 0, 255) ;

The first and second arguments of setLargeLEDs denote
what range of LEDs to turn on. The other three arguments
are the components of the color.

Turn on a range of small LEDs with setSmallLEDs
SpinWheel. setSmallLEDs( 2, 7, 255, 255, 0) ;

The first and second arguments of setSmallLEDs denote
what range of the 1 2 LEDs is to be turned on. The other
arguments are the red, green, and blue components.

Set color using a single hex variable
( 255, 129, 0) → 0xff8100

All of the color- related functions can be used with a single
color variable in the standard hex notation (a common
method of referring to colors) .

Set overall brightness with setBrightness
SpinWheel. setBrightness( 50) ;

This function takes only one argument, between 0 and
255, that sets the brightness of the LEDs. At maximal
settings the large LEDs are blindingly bright and pull a total
current of 480 mAh, which would deplete our battery in
less than 1 0 minutes. Using the maximal setting would
cause the battery to wear out much quicker and would
cause significant heating.
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Custom LED patterns

Thanks to these functions you can easily set al l of the LEDs
to a preset pattern. They are useful building blocks for
commonly used patterns.

Rainbow pattern with setSmallLEDsRainbow
SpinWheel. setSmallLEDsRainbow( 120) ;

This function takes only one argument between 0 and 255,
representing a fraction of a whole circle, determining
where a rainbow pattern should start. The start of the
circle is represented by 0, halfway through is 1 28, and a ful l
circle is 255.

Circular progress bar with setSmallLEDsProgress
SpinWheel. setSmallLEDsProgress( 200, 0, 0, 255) ;

You can use this to create an arc around the SpinWheel
with the small LEDs. It has four arguments: an angle that
specifies the extent of the arc, and the red, green, and blue
LEDs brightness. Each goes from 0 to 255. To have an arc
that l ights up LEDs 0- 9 in blue, use setSmallLEDsProgress(192,

0, 0, 255) .

Circular pointer with setSmallLEDsPointer
SpinWheel. setSmallLEDsPointer( 100, 255, 255, 0) ;

This is similar to the above function, but instead you can
specify the middle of the arc. Simply specify the angle for
the middle of the arc (0- 255) and the color.

Color and brightness helpers

Various functions that help prepare colors or map a given
number to a continuously changing brightness. A good
place to see why these functions are useful is the set of
lessons on animations.
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A colorWheel
colorWheel( 100)

The colorWheel function turns a single number representing
an angle into a color from the color wheel.

The triangularWave function creates a pulsing
pattern
triangularWave( 150)

The triangularWave function provides a convenient periodic
function, useful in animations.

The color wheel lets you generate a color based on a single
continuously changing (maybe time- dependent) number. The

red, blue and green components of the colors in the color wheel
are shown in the plot on the right.

An il lustration of the triangular wave function which can be used
to create periodic patterns.
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A more pleasing pulsing pattern with
parabolaWave
parabolaWave( 150)

Similar to triangularWave, this function provides a periodic
pattern, but it can be smoother and more pleasing.

Motion sensing and compass with readIMU

To request measurements from the sensor you need to
call readIMU. Then the measurement data wil l be available
in ax, ay, az , gx, gy, gz , mx, my, mz . The acceleration along the
three axes ax, ay, az is measured in units of g , i .e. the
ostandard gravitational acceleration at Earth’s surface.
The angular velocity components gx, gy, gz are measured in
units of degrees per second. Lastly, the magnetic field mx,
my, mz is measured in units of μT. There is also a
temperature sensor, but we do not yet provide direct
access to it.

The orientations of the axes of the SpinWheel motion sensor.
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